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1 Installation and Release 
Notes
Installing TerminalOne

Click on the link to the TerminalOne .dmg file from the download page at the Yrrid website:

http://www.yrrid.com/Products/TerminalOne/Download/

An alert panel will appear:

Click on Continue if you wish to download TerminalOne.

After the file has downloaded, TerminalOne.app will appear in your Downloads panel. The TerminalOne.app icon 
will appear on your desktop. Double-click on the icon to launch the app. You can drag the TerminalOne icon to 
your Applications folder.
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Registering TerminalOne

TerminalOne run in demo mode allowing 30 minute sessions allowing you to try out the application. 

You can purchase a license for TerminalOne by clicking on:

TerminalOne -> License to bring up the License Activation window:

If you have already purchased a valid activation code you can enter it in the text field and click Done.
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You can purchase a license for TerminalOne by clicking the Purchase via Kagi button. This will bring up the Pur-
chase From Kagi panel.: 

Click on the Buy Now button. TerminalOne will connect securely to the Kagi website and bring up the Purchase 
From Kagi window with the relevant information filled in:

Enter your information and click Purchase!
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2 About this Manual
The TerminalOne System Administrator’s Guide can help readers configure and use TerminalOne terminal sessions. 
It presumes a reasonably good understanding of the Mac OS X ® user interface.

Although this guide does describe how TerminalOne supports attributes of specific terminal emulations, it deals 
mostly with the TerminalOne terminal and communications application itself. It does not detail the functional prop-
erties of the proprietary terminals; for that you must consult the appropriate terminal’s reference manual.

This manual is organized as follows:

• The Introduction gives a brief overview of TerminalOne and its features.

• Getting Started walks through a simple example of how to configure and save a TerminalOne session.

• Preferences describes how to configure the TerminalOne user preferences.

• Using TerminalOne describes TerminalOne’s commands to open, close, save, and control terminal sessions.

• Configuration details the configuration options TerminalOne supports for terminal sessions.

• Advanced TerminalOne Configuration describes advanced system administration topics.

• The appendices describe the configureable attributes supported on each of TerminalOne’s emulations.
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3 Introduction
TerminalOne is a VT100 (VT102) VT220 VT320 and IBM 3270 color terminal emulator for Mac OS X available 
as a Universal Binary.

TerminalOne supports these features:

• DEC VT320, VT220, VT102, and IBM 3270 

• Fully native application written from the ground up in Cocoa

• Very fast startup and session creation times

• Proven emulations used in corporate production environments

• Accurate VT320 terminal emulator with color xterm extensions

• Accurate VT102 terminal emulator with Terminal behavior

• Supports text wrapping on resize, copy & paste 

• Supports all graphics characters with any font, supports any font, fixed width or not 

• Flexible scrollback, unlimited or limited by lines or memory size

• Tabbed Sessions of different sizes in one window 

TerminalOne is highly configureable, easy to administer, and easy to use.

TerminalOne’s additional features are:

Standard Interface

TerminalOne’ object-oriented design lets you make use of many standard user interface features. You can:

• copy text and graphics to and from TerminalOne using Cut, Copy, and Paste

• use inspectors to customize attributes of the current terminal session,

• set printing parameters such as margins, black and white/color, page layout,

• print the output from the entire terminal session, a selected portion of the session, or the visible portion of 
the screen as Full Color, as Color or B&W on no background; or print to an attached printer (DEC VT320 
only),

• configure window attributes -- titles, resizing and closing behaviors,

• resize the terminal window changing the number of rows and columns or rescaling the font,

• set the color of each terminal’s foreground, background, and text attributes,

• configure scroll, drag and drop, cut and paste behavior,

• configure emulation specific parameters,

• load and store custom configurations as .term1 files,
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• autolaunch configurations on TerminalOne start-up.

Keyboard and function key support

TerminalOne provides extensive support for keyboard customization. 
You can:

• map keys from the emulated terminal's keyboard onto your machine's keyboard using a graphical interface,

• remap keys to arbitrary string values or macros,

Communications

TerminalOne allows you to connect a terminal to:

• remote hosts through telnet,

• a specified shell or command,

Administration

• Users can share TerminalOne configurations. Anyone can create libraries of TerminalOne configurations 
which can be used at the owner’s discretion.
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4 Getting Started
If you’ve installed TerminalOne for the first time, this chapter will show you how to create a new session, change 
an important attribute like the emulation, set the command, and save the configuration so that it can be used later. 
You will also see how to map a key.

Launch TerminalOne by double-clicking on the TerminalOne icon. This should bring up a VT102 window con-
nected to the bash shell... 

The terminal window will have the following default title:
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Getting Started
To create a new session, click on the File -> New Session item of the TerminalOne menu or hit Cmd-N on the key-
board. 

A new terminal window will appear. The new terminal session is, by default, an 80 column, 24 line VT102 con-
nected to the bash shell.

To select a different emulation or connection option, click on File�Show Info or hit Cmd-I on the keyboard. 

TerminalOne’s Inspector will appear. Click on Emulation in the Inspector directory (on the left); the 
Emulation Inspector will appear with the current emulation selected:

Note that these inspectors always focus on the current or key session. Right now the Emulation Inspector is 
inspecting your new VT102 session. Select the terminal emulation you want by clicking the cursor on the terminal 
in the right scrollview and pressing the OK button.
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Getting Started
For this example, we’ve selected VT320. The VT320 Inspector should now be visible, and the current terminal ses-
sion, which is also the key window, becomes the selected emulation:

This VT320 terminal session is still connected to the default shell at the home directory. To change this, click on 
Shell/Command in the Inspector under Connection to display the Shell/Command Inspector.

Click Disconnect to make the Command and Directory fields editable. You can edit the fields directly or click on 
the Set buttons on the right to bring up a browser view. We will connect via telnet to the host: myHost. To do this 
enter /usr/bin telnet myhost in the Command textfield and click connect:
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Getting Started
TerminalOne will try to connect via telnet to the host mentioned (a VT320 legacy system screen is shown):

To set the Environment Variable, disconnect the session and select Environment to bring up the Environment 
Inspector. Select a variable in the Environment Variables textbox. The value is shown below in the Selected vari-
able value: textbox. You can edit these directly. To add or remove a variable, click the Add or Remove buttons.:

Go back to the Shell/Command Inspector and click the Connect button. 

Before you save this terminal session you will probably want to add a name to the window title to identify it. To do 
this click on Window Title under General to display the Window Title Inspector. Click in the Main and Mini text 
fields and add the name to the window titles.
4-4 TerminalOne System Administrator’s Guide



Getting Started
The Window Title Inspector will now look something like this:

The main window will look something like this:

The miniaturized the window looks like this:

When you move your mouse over this miniaturized window, the Mini Window Title will be displayed. 

To save this configuration for later use, click File�Save to bring up the Save panel. Use this browser to find the 
directory to save the configuration. Unless you’re grouping configurations in special directories, the default direc-
tory ~/Library/TerminalOne is as good a place as any (~ indicates your home directory). Enter the configuration 
name in the Save As text field and press the Save button.
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Getting Started
In order to open a saved configuration in the directory ~/Library/TerminalOne click on 
File�Library�<configuration name>. The saved configurations will appear in the library menu:

To open a terminal session with attributes of the saved configuration, click on the <configuration name>.

You can also open a configuration by clicking on File�Open... and selecting a .term1 file or by double-clicking on 
a .term1 file in the Finder.
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Getting Started
Mapping a Key

When using TerminalOne you may want to map certain keys. We will map the function key, PF1 to the 1 key on the 
numeric keypad. Select Key Map on the left hand side under General to bring up the Key Map Inspector. Select the 
Keypress field and press the 1 key on the numeric keypad on the right hand side of your keyboard. TerminalOne 
will display the displayed value and the default key mapping (\<key:kp1>). Enter \<key:pf1> in the Maps To: tex-
tfield.

Click Add to map the key. The list of re-mapped keys will appear on the listbox above.

To reset to the key’s default mapping, select it from the listbox, clear out the Maps To: textfield and hit return.
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Getting Started
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5 Preferences
TerminalOne�Preferences... allows you to change TerminalOne’s general behavior for your account. TerminalOne 
stores these preferences in each user’s defaults database. You can specify, for example, what sessions TerminalOne 
will open when you launch it, what session TerminalOne will open for the File�New Session command, and how 
TerminalOne responds to the Quit command.
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Launch Preferences Preferences
Launch Preferences

When you launch TerminalOne, it opens a VT102 session connected to the bash shell. If you click the Add... button, 
an Open at Launch panel will appear. Use this directory browser to select the .term1 files that TerminalOne will 
open when you launch it. Note that if you’ve just installed TerminalOne for the first time, the only configuration 
you have is the default configuration, ~@/DefaultTerminal.term1 (~@ indicates the TerminalOne.app directory 
of the currently executing TerminalOne application). The chapter Getting Started gives an introductory example of 
how to configure a session; the chapter Configuration details the non-emulation-specific configuration options.
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General Preferences Preferences
General Preferences

General Preferences allows you to change the default session TerminalOne opens when you use the 
File�New Session command. The default session, ~@\DefaultTerminal.term1, is a VT102 (80 columns by 24 
lines) terminal connected to the bash shell.

Default Session

Enter the pathname of the .term1 file you want as the default session. Clicking on the Set ... button brings up an 
Open panel. You can use this directory browser to select a Default Session .term1 file.

Use Backup~ Files

If you check the Use Backup~ Files box, then whenever you save a configuration, TerminalOne will back up the 
previous .term1 configuration file. For example, if you open the .term1 file just-the-vax.term1, change its 
attributes and save it, then TerminalOne saves the previous configuration in the file just-the-vax.term1~.
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Quit Preferences Preferences
Quit Preferences

If you issue the quit command and still have sessions open, TerminalOne will, by default, prompt you with the fol-
lowing Alert panel:

If you want a similar Alert panel even when there are no open sessions, then check the Even with no sessions box. 
Now when click on TerminalOne -> Quit TerminalOne you will see the Really Quit? panel. If you press the Cancel 
button, TerminalOne will still remain running. To open a new session, you must click File -> New or hit Cmd-N. 
Note: You much first make sure that TerminalOne is the active application.You can do this by clicking on a Termi-
nalOne inspector window, or by clicking on the TerminalOne icon on the dock.

If you want a similar Alert panel when logging out, then check the Verify quit when logging out box. If you do not 
want any Alert panels, then uncheck all boxes.
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6 Using TerminalOne
This chapter describes TerminalOne’s standard   commands, how to initiate and save sessions, how to control the 
state of a session, and describes the behavior of mini windows.

Standard commands
TerminalOne supports the following standard commands:

• File

• Edit

• Scrollback

• Font

• Window

• Help
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File Using Termi-
File

Initiating sessions

New Session

New opens a new session using the Default Session configuration specified in the
Info�Preferences�General panel.

NOTE: If you use New to create a new default session, alter the session’s configuration and Save, then 
TerminalOne will bring up the Save As panel which you can use to specify the name of the new configuration.

New Tab

New Tab opens a new tabbed session using the Default Session configuration specified in the
Info�Preferences�General panel.

Library

Selecting Library brings up a menu of configuration files. Click on a Library menu item to start a session. To 
access TerminalOne sessions through the Library menu item, the corresponding .term1 files should be placed in 
~/Library/TerminalOne. You can change the directory location of the TerminalLibrary by editing the Termina-
lOne.defaults file.
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File Using TerminalOne
NOTE: If you use Library to open a session, alter its configuration and Save, then TerminalOne will not automati-
cally overwrite the .term1 file you opened. It will, instead, bring up the Save As panel which you can use to specify 
the name of the new configuration.

Open

Open allows you to create a session using any TerminalOne configuration file you can read. Clicking on Open 
brings up an Open panel. Use the Open panel’s browser to locate the TerminalOne file you want to open:

Saving session configurations

Close

Close terminates the current session. If you checked the Confirm window close box in 
File �Show Info�Inspector�General�Miscellaneous and close a session, then TerminalOne will bring up an 
Alert panel to confirm that you really want to close the session. Clicking Close is equivalent to clicking the session 
window’s close button.

Save

Save saves the session configuration in the currently opened TerminalOne file. TerminalOne will automatically 
save the configuration if you already Opened the session or if you used the Save panel to save the configuration. If 
TerminalOne cannot automatically save the configuration, it will bring up the Save panel so that you can specify 
the .term1 file name.

Save As

Save Text As brings up the Save panel so that you can save the session configuration under a different name. Once 
you have used the Save panel to save the configuration as a .term1 file, you can change the session configuration 
and Save, and TerminalOne will automatically overwrite the .term1 file.

Save Text As

Save Text As brings up the Save panel so that you can save the text of the session to a TextEdit file. 

Save Selected Text As

Save Selected Text As brings up the Save panel to save the selected text of the session to a TextEdit file. 
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File Using Termi-
Show Info

Show Info brings up the Terminal Inspector panel with the last viewed inspector selected and shown. You can select 
from the list on the left-hand side to bring up the appropriate inspector. 

Send Break

Send Break sends the "break" command. 

Send Reset

Send Reset sends the "reset" command. 

Send Hard Reset

Send Hard Reset sends the "hard reset" command. 

Page Setup

Page Setup brings up the Page Setup panel. 

Print

Print brings up the Print panel. Click on the Copies & Pages dropdown box and select TerminalOne for the appro-
priate options.
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Edit Using TerminalOne
Edit

The Edit menu contain the standard commands and some TerminalOne specific options.

Cut, Copy, Paste, Select All 

TerminalOne supports the standard Cut, Copy, Paste, and Select All commands.

Paste Selection

Paste Selection pastes the selected text from the session at the current prompt.

Paste Escaped Text

Paste Escaped Text pastes the escaped selected text at the current prompt.

Find

Find brings up the Find panel.

Special Characters

Special Characters brings up the Character Palette.
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Scrollback Using Termi-
Scrollback

Scroll to Top scrolls the terminal session back to the top.

Scroll to Bottom scrolls the terminal session to the bottom.

Page Up scrolls up one page.

Page Down scrolls down one page.

Line Up scrolls up one line.

Line Down scrolls down one line.
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Font Using TerminalOne
Font

Show Fonts brings up the Font panel.

Bigger increases the font size.

Smaller decreases the font size.

Show Colors brings up the Color panel.
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Windows Using Termi-
Windows

The Windows menu allows you to arrange TerminalOne windows that are open. The list of open TerminalOne win-
dows is at the bottom of the menu with the key window checked. You can select a window from that list to make it 
the key window.

Minimize minimizes the key TerminalOne window.

Zoom expands the key TerminalOne window to fill the screen area.

Next Terminal make the next terminal the key window.

Previous Terminal make the previous terminal the key window.

Bring all to Front brings all the TerminalOne windows to the front.
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Appendix A DEC VT320
Emulation Attributes

Identification

Drag and release the Identification option list to select the terminal identification. The VT320 emulation can iden-
tify itself as either a VT320, VT220, VT102, VT101, or VT100.

Status Line

• Disabled disables the status line. (Restores the original number of rows.)

• Empty enables the bottom row of the screen as an empty status line. This reserves an unwritable sta-
tus line.

• Indicator enables the bottom row of the screen as a status line displaying the cursor position and 
printer status.

• Writable enables the bottom row of the screen as a writable status line.

Enabling a status line causes the screen to become shorter by one row.

Controls

• Interpret causes the terminal to interpret unprintable characters normally.

• Display causes the terminal to display unprintable characters as printable strings, e.g. the CR charac-
ter is displayed as <CR>.
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Emulation Attributes
Preferred Set

• DEC Supplemental causes the terminal to map the keycodes in the range 128-255 to the 
DEC Supplemental character set.

• ISO Latin 1 causes the terminal to map the keycodes in the range 128-255 to the
ISO Latin 1 character set.

Auto Wrap

Selecting Auto Wrap causes text entered past the last column to wrap onto the next row.

If you don’t check Auto Wrap, then, when text is displayed past the last column of the current row, the cursor will 
stop at the last column; each new character will overwrite the last one.

Back Wrap

If you check the Back Wrap option and use the Delete key to delete text that has wrapped over multiple lines, Ter-
minalOne will backtrack the cursor over the wrapped line. If you do not check Back Wrap, then the Delete key will 
still delete text, but the cursor will stop at the first column of the current line.

Note that Back Wrap only affects the behavior of backspace (BS) keycode.

8 Bit Mode

Check the 8 Bit Mode box to allow the session to display and transmit multinational characters in the upper 128 
characters.

Tabs

• None removes all tabs.

• Eight puts a tab every eight columns.

You can also insert a tab by positioning the cursor in the tab ruler and clicking. To delete a tab, position the cursor 
over it and click.
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Emulation Attributes
Keyboard

Select Emulation�Keyboard in the Inspector directory to display the Keyboard Inspector. This inspector allows 
you to change the mapping of the Cursor keys, Keypad keys, the Delete, Return, and Meta Keys, and to edit the 
answerback string.

Cursor Keys

Unchecking the Cursor Keys box passes the cursor keycodes on to the application without translating to a VT series 
escape sequence.

Checking the Cursor Keys box enables one of the following options:

• Normal converts the cursor keycodes to the VT series “normal” escape sequence.

• Application converts the cursor keycodes to the VT series “application” escape sequence.

Keypad Keys

Unchecking the Keypad Keys box passes the keypad keycodes on to the application without translating to a VT 
series escape sequence.

Checking the Keypad Keys box enables one of the following options:

• Numeric converts the keypad keycodes to the VT series “numeric” representation.

• Application converts the keypad keycodes to the VT series “application” escape sequence.
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Emulation Attributes
Meta Keys

Unchecking the Meta Keys box makes the Alternate key function normally.

Checking the Meta Keys box enables one of the following options:

• Escape causes the Alternate key to function as the EMACS meta key. If you hold down the Alternate 
key and press, for example, the a key, TerminalOne will send the ESC (escape) character 
(0x1B) and then the a character (0x61).

• High Bit causes the Alternate key to set the high bit in the character code. If you hold down the Alter-
nate key and press, for example, the a key, TerminalOne will send the code 0xE1.

Delete

Unchecking the Delete box maps the Delete key to its value in the Keyboard mapping.

Checking the Delete box maps the Delete key to:

• DEL the DEL (delete) character (0x7F).

• BS the BS (backspace) character (0x08).

Return

Unchecking the Return box maps the Return key to its value in the Keyboard mapping.

Checking the Return box maps the Return key to:

• CR the CR (carriage return) character (0x0D).

• CR-LF both the CR and the LF (line feed) characters (0x0D and 0x0A).

Answerback

The DEC VT series terminals send the answerback string back to the host in response to the host sending the ^E 
(control-E) command. 

Click in the Answerback text field to add or edit the answerback string.
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Key Macros
Key Macros
NOTE: You can also use macros defined on other VT series key palettes.

VT320 Function

The following key macros are defined in the VT320 Function key palette (Tools�Key Map):

f6, f7, f8, f9, f10, f11, f12, f13, f14, f15, f16, f17, f18, f19, f20

shift-f6, shift-f7, shift-f8, shift-f9, shift-f10, shift-f11, shift-f12, 
shift-f13, shift-f14, shift-f15, shift-f16, shift-f17, shift-f18, shift-f19, shift-f20

find
insert
remove
select
prev
next

Additionally the following key macros are defined:

f1, f2, f3, f4, f5

shift-f1, shift-f2, shift-f3, shift-f4, shift-f5

left
up
right
down

pf1, pf2, pf3, pf4

kp0, kp1, kp2, kp3, kp4, kp5, kp6, kp7, kp8, kp9
kp-minus, kp-comma, kp-enter, kp-period, kp-plus

help
do
print-screen
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References
The following manuals on the VT series are available from DEC:

VT220 Owner’s Manual

VT220 Programmer’s Manual

VT320 Owner’s Manual

VT320 Programmer’s Manual
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